GEOPAK 2001 Update 2001.00.01 Parcel Subdivide Enhancements

Updated File(s):

gpkserv.ma

gpktools.ma

sbdiv.dll

sbdiv.ma

subdivide.cnt

subdivide.hlp

Description:

GEOPAK now provides an application in the form of a wizard to assist in complete 

subdivision layout. The application recognizes boundaries and road frontages to 

correctly layout and compute lot geometry based on an array of user defined 

constraints. In addition to computing the geometry, the application displays 

direction and distance information along with setback and envelope graphics to 

provide the user visual confirmation of lot geometry and dynamic editing. All 

geometry is stored into the coordinate geometry database for easy download for 

field staking.GEOPAK 2001 Update 2001.00.06

Updated File(s):

acbook.ma

sheetclp.dll

sheetclprn.ma

sheetclprm.ma

sheetclp.ma

sheetclp.cel

sheetlib.ma

gprefer.ma

gpktools.ma

gpkserv.ma

projmgr.ma

gsmain.ma

xsamn.ma

shranot.ma

shrgpkmn.ma

maccvsdl.dll

macanot.dll

macmrep.dll

macgeom.dll

default.cel

default.psl

Description:

This new update will replace the existing plan/profile sheet (PLPRCLIP.MA) application.  

It contains all the current capabilities of PLPRCLIP.MA with many additional functionalities 

including but not limited to:

-Flexible combinations of ports in a sheet (plan/plan, plan/profile, profile/profile, 

plan/profile/profile, plan/profile/tabulation...)

-Predefined sheet libraries each may contain multiple sheet configurations

-Different views of the same area of coverage on the same sheet

-Reference file capabilities (raster references, saved views, level symbology)

-Sheet masking allows for "notching" of a sheet for title blocksD

-Dynamic sheet modifications

-Right to left sheet progression

-Provisions for lengthened profile view due to gaps in station equations or profile grid 

alignment

-Profile stair stepping to accomodate certain terrain conditions

-Sheet number editing or renumbering capabilities

-Sheet based tabular data annotations

-Sheets may start prior to the chain's beginning point and terminate after chain's ending 

point

To activate the new plan profile sheet application, access the pulldown menu 

Applications > GEOPAK Road > User Preferences.  

Set Plan & Profile Sheet Compatibility to GEOPAK 2001+.

Access menu Applications > GEOPAK Road > Plans Preparation > Plan & Profile Sheets

GEOPAK 2001 Update 2001.00.29

Updated File(s):

create3d.ma

culvert.ma

drain98.ma

drain98.dll

drain.cnt

drain.hlp

dtmgpk98.dll

dtmgpk98.ma

dtmic98.ma

dtmlod98.ma

dtmlst98.ma

gsdrntls.ma

gseldiff.ma

gsewer.dll

gshgt.ma

gsmdfelm.ma

gsprof.ma

gssectn.ma

gssetht.ma

gsslarea.ma

gsstprof.ma

gsthemes.ma

gstrslp.ma

gsvis.ma

gsvolume.ma

hamn.ma

labeler.ma

macanot.dll

maccvsdl.dll

macgeom.dll

macmath.dll

macmrep.dll

macutil.dll

selctlbl.ma

sheetclp.dll

shranot.ma

shrgpkmn.ma

site98.dll

site98.ma

tc.ma

updlabel.ma

vamn.ma

watsew.ma

xsamn.ma

xsdmn.ma

Description:

This update resolves known change tickets in addition to offering enhancements to the  Site Modeler, the Digital Terrain Model, Drainage, Water and Sewer, Profile and Cross Section Tabular Annotation, and miscellaneous computational items.

The following new features were added:

1. A new contour smoothing algorithm.

2. Enhancements to the site modeler slope element tool to handle simple benching options.

3. A rename Site Object feature

4. A new tool, Slope Trace, which will trace a constant slope along a surface.

5. Enhancement to the Site Modeler>Project>Export>To COGO Profile that allows the user to add a delta value to the created profile elevations.

This update also resolves the following change tickets:

DCAT-4XYKJG

Site Modeler->Elements New Edit->Section. Corrected a problem where a section did not follow the graphic it was originally attached to.

DCAT-4Y5LTR

JVOE-4ZNLBB

Site Modeler->Analysis->Drainage Tools->Pond Analysis. Corrected problem with volume calculations and pond limits when the pond contained flat areas.

JVOE-4Z9HMD

Site Modeler->Element->Edit Profile. Corrected problem where certain design file global origin settings would prevent the profile from appearing.

MGIM-4Z77XB

Site Modeler->Element->Slope Element. Corrected problem with incorrect message stating no solution found and where the direction of the element was reversed.

AMAE-54BHQA

Site Modeler -> Volumes. Corrected problem where volumes by FIFO was returning 0.0 as total volume.

GPKN-548NTE

Site Modeler->Analysis->Volumes. Corrected problem with outputting report that caused the tool to unload.

GPKN-544KGG

Site Modeler-> Delete Element Z. Corrected the problem where it would only delete one element from the selection set.

AMAE-54EJNA

DTM -> Analysis -> Elevation Difference. Corrected the problem where the number of grid points would apply to the window when display only was on and the extents when toggled off.

MGIM-4Z787A

Site Modeler -> Element -> Delete -> Corrected a problem where only one element was deleted even if a selections set/power selector set was used.

MGIM-4Z87Y8

Site Modeler -> Element -> Side Slope -> Corrected a situation where the Element Side Slope tool would crash.

MGIM-4ZF3SX

Site->Draw profile Tabular Annotation -> Corrected a speed issue when large data sets are used.

MGIM-4ZF4CN

Site-> Draw profile Tabular Annotation -> Corrected an issue where the last tabular value was omitted.

MGIM-4ZF4KU

Site-> Draw cross section Tabular Annotation -> Corrected an issue where data located at an even interval was not displayed.

MGIM-4ZF4NC

Site-> Draw cross section Tabular Annotation -> Corrected an accuracy issue where data at the extremes of a Cross section may be omitted.

MGIM-57HJZ6

Site->Draw cross section Tabular Annotation -> Annotating cross sections based on plan view locations would crash the tool - this has been fixed.

MGIM-57HSZQ

Site->Draw cross section Tabular Annotation -> Annotating cross section cut and fill areas had the values displayed in the reverse order. This has been corrected.

MGIM-57HTDE

Site->Draw cross section Tabular Annotation -> When adding collection point values to the list, multiple add/remove actions would delete all values from the list. This has been corrected.

MGIM-58NSSS

Site->Draw cross section Tabular Annotation -> Corrected an issue where, given certain circumstances, some of the annotation would be omitted.

MGIM-58NT3P

Site->Draw cross section Tabular Annotation -> If the XS graphics was below the XS Cell Hz datum, the annotation would not recognize the XS elements. This has been corrected.

MGIM-58NSW6

Site->Draw profile Tabular Annotation -> Corrected an issue where the Tabular annotation would be shifted if the Profile Cell did not start at the beginning of the chain.

MGIM-58NSYS

Site->Draw profile Tabular Annotation -> Corrected an issue where, under a certain condition, adding element symbology to the Design Elements Tab variables would cause the tool to crash.

MGIM-4XE8NL

DTM -> BUILD -> DELTA SURFACE -> Corrected an issue where the Delta TIN To and From TINs were in a different order to all of the other DTM tools.

------------------------------

GPKN-4ZVP3R

Drainage>Networks>Design. Corrected problem where certain networks were prevented from completing the Design process.

DCAT-544U8B

Drainage>Culverts>Headwall Location Tab>Create Profile Button.  Corrected problem where the created pipe profile was incorrectly sized.

JVOE-53TM5R

Drainage>Areas>SCS Method>Computed Discharge.  Corrected problem where the computed discharge always equaled to zero.

JVOE-53TMFM

Drainage>Areas>Time of Concentration.  Corrected N value label in Shallow Flow section to Inter. K value.

DCAT-524VYG

Drainage>Navigator>Edit>  Corrected Node modification routines which caused an mdl abort in drainnod.mc@2792&585

AMAE-54VJSD

Drainage>Node Configuration>Curb Inlet in Sag>  Corrected problem where Depression information was always reported equal to zero.

DCAT-4R46LT

Drainage>Components>Links>Conditions Option> Corrected problem where the Link slope was not automatically updated during a Network Analyze command.

YAGE-562NLN

Drainage>Preferences>Link Options>Link Slope Decimal> Corrected a problem where a combination of held link elevations and zero decimal rounding caused an erroneous soffit elevation error message.

GPKN-56FLK4

Drainage>Library>Sag Grate Inlets> Corrected a problem where the reduction factor became inverted.

--------------------------------------

DMAE-54WLAS

Road>Plan View Labeler>  Corrected a problem where selecting certain MicroStation elements caused the gpk job number and chain to be removed from the labeler key-in fields.

DCAT-4Y6QGH

Road>Labeler>Label Updater> Corrected problem where arc type labels always need to be updated.  The Label Updater always returns these labels as 'Content Needs Updating'.

GPKN-549LC3

Road>Plan View Labeler>  Corrected problem where the Edit Label tool allowed selection of reference file elements.

---------------------------------------

GPKN-57QL65

Water Sewer>Fixed a problem where certain miscellaneous utilities did not display properly in profile view.

DCAT-588NS7

Water Sewer>Fixed a problem where the message "cell not found in attached library" erroneously appeared.

DCAT-562NZS

Water Sewer>Fixed a problem where the message "unable to load Profile T" erroneously appeared.

DCAT-588NLV

Water Sewer>Fixed a problem where the sewer profile's ground line did not update based on active site model.

DCAT-58NSRC

Water Sewer>Fixed a problem where the Auto Locate Sewer Node tool spaced sewer manholes too close together.

GPKN-556M4H

Water Sewer>Fixed a problem where drainage links did not show up as crossings if the link name contained only 4 characters.

DCAT-589LK4

Water Sewer>Fixed a problem where lines based on cogo chains did not update if the cogo chain was modified.

DCAT-58MT5B

Water Sewer>Fixed a problem where the Update All Profiles command aborted.

DCAT-582M7X

Water Sewer>Fixed a problem where very long water lines did not honor the default depth in the last segment of the line.

DCAT-4ZT8D6

Water Sewer>Fixed a problem where the conflict finder would return no conflicts if the drainage file (gdf) was not attached in the Water Sewer Preferences.

DCAT-582Q9R

Water Sewer>Fixed a problem where the Labeler's Sewer Segment selector would return "err" if sewer lines were selected in an increasing to decreasing (number of segments) order.

DCAT-589NUS

Water Sewer>Fixed a problem where the Labeler would return bad pointer to free.

DCAT-57JTNN

Water Sewer -> Water Line Profiles -> Pipe Profile Tab -> A dynamic graphic Circle will now highlight the location of the current profile point from the list in the Profile graphics.

DCAT-56U5LM

Water Sewer -> Navigator -> Corrected the availability of the ID button when navigating Profiles.

--------------------------------------------

ENHANCEMENTS

JVOE-55YKLC

Water Sewer>Added auto-update feature based on revisions to water or sewer lines with simple microstation modify commands.

Site Modeler -> Auto save -> Fixed the timing on the Auto save.

Site Modeler -> Project>Export>To COGO -> Fixed the number of points exported for a curve. Points exported will now be exactly what the User specifies in the dialog.

Site Modeler -> Model>Object Clipping -> resolved clipping of Objects from Model issues.

Site Modeler -> Analysis>Profile -> Fixed an issue where, if an old resource file held the name of an Object or Model that was not in the current project, the tool would close.

GEOPAK 2001 Update 2001.00.31

Updated File(s):

acbook.ma

cmp.ma

xs.exe

brtools.dll

sqlAccess.txt

sqlOracle.txt

sqlServer.txt

Description:

This update contains major enhancements in Design and Computation Manager to support automated

quantity computations, new features include:

- compute quantities along multiple baselines in a single run.

- output to Quantity Manager database, database may be in Microsoft Access, SQL Server or

Oracle.

- output directed to screen for preview or file.

- manage synchronization of graphic elements and Quantity Manager database.

All quantities in Quantity Manager from Design and Computation Manager carries a unique DGN

file name, element ID, run name and time stamp in order to automate updating.

- support extended usage of 3PC to process computation, unifying Comp Book, Item Reports,

SDF Export, and DBMS Export modes for both standard units as well as 3PC custom computation

methods.

- In DBMS mode with 3PC, payitem ID, description, extended description and remarks may be

composed and passed to Quantity Manager for reporting purposes.

- support of Display tools directly on the Compute dialog.GEOPAK MR2001 Update 2001.01.01

Updated File(s):

sdmsconv.ma

Description:

This update resolves the following change ticket:

CPAR-5AULRZ

COGO>Import SDMS Alignments:  Make enhancements to allow Ver 3.4 SMDS profiles to be imported.

GPKN-5JXN4V

SURVEY>COGO>iMPORT>SDMS ALIGNMENTS & POINTS: Importing SDMS alignment to

GPK (attached file on change control ticket) On Geopak2001+ MR2001.05

+ MR2001.01.04+ MR2001.01.01 will result on the following message on the 

cogo dialog:

Curve C38 stored

WARNING : Incomplete STORE CHAIN command

ACTION  : Enter CURVE name

It runs thru Cogo and store several points, then the message a dialog that 

reads: "Horizontal alignment file imported successfully" will appear, but 

the chain is not stored in the GPK. Sometimes it will able to store the chain 

after running  the same file several times.

GEOPAK MR2001 Update 2001.01.04

Updated File(s):

geosrvy.ma

survmngr.ma

obseditor.jar

cgcondll.dll

ll2obs.dll

xsreport.ma

dtmgpk98.ma

dtmic98.ma

dtmtrm.ma

gpktds.ma

bfitall.ma

survutil.dll

Description:

This update resolves the following change tickets:

AMAE-5LEPGQ

Geopak Survey Data Collection : 

When converting a raw file to .OBS and .CTL the Point code in the .OBS for a control 

point doesn't match the point code shown in the .CTL file for the same point. 

RJMS-5DPNLU

SURVEY>DATACOLLECTION>DATA TRANSFER: When using TDS data with repetition

data and the user chooses to ignore repetitions to use just the averages,

some repetitions are still showing up in the OBS file.  In addition, some

side shot files would combine two side shots to two different points into a

single observation causing pointing errors.

FABD-5CRR3M

SURVEY>SMD FEATURE TABLE: Points with custom descriptions are getting an

additional field comment because from the field parameters description and

comments are being sorted differently upon import.

FABD-59SJTL

Survey>Mapping - When plotting points with attributes setup in the .SMD

file: Parameter number 5 gets plotted in place of Parameter number 2, and

#2 is placed at the end. This happens when either note is left blank or

not.

Point is correctly in .XYZ file and in COGO window if you do a point

describe, however it is mapped incorrectly.

CPAR-5A8GMK

DTM Menu>Utilities>Export DTM to Trimble.  Change the "Export DTM to

Trimble " menu option to "Export DTM" .  Change the dialog to add the Leica

GSI DTM to the option button.

CPAR-5A8GRY

Road>Cross Section Reports>Multiline:  When exporting Leica Templates,

export the last leg of the cross section defined by a slope.

GPKN-5C4LJD

SURVEY>DATA COLLECTION>DATA TRANSFER: WILDGIF-10/WILDSOFT2: With

GEOPAK2001+MR when transferring raw data to the OBS the set up HI and

Backsigth information are missing in the OBS and it will not process.

MMOY-5CTPRY

SURVEY>DATACOLLECTION>DATA TRANSFER: Undesired Gaps are being introduced in

the Chain when using linking codes like . for begin line and .. for end

line are used.

FABD-5DEN5M

SURVEY>DATACOLLECTION>CONVERSION: Two problems here:

1.- TDS averages  to the foresights are not being written to the OBS file.When 

transferring the TDS raw data to OBS it always put the redundant data regardless 

of whether you choose the TDS averages (by pressing cancel).

2.- When pressing OK to transfer redundant data it is reading the TR data (traverse 

record) as another direct Observation therefore the OBS file will have a D-R-D set 

without the last R, it will give the user a wrong felling that  they did not completed 

the set D-R-D-R on the field RAW data.

AMAE-5E6P83

SURVEY>SURVEY DTM>BUILD DTM: Determine breaklines from: "all chain points included" 

and "Point /chain attribute  field " are not honoring the breaklines.

AMAE-5E4NMH

SURVEY>MENU BAR> OPEN COORDINATE FILE> Can not open CRD files

FABD-5EWJNS

SURVEY>DATACOLLECTION>DATATRANSFER: The file CALCPTS.NUM is not being read

when creating a new OBS file. It is being updated but not read, therefore

the CALC points will not be automatically upgraded to the next available

number on the following .OBS file of the next run

MMOY-5EZSRE

GEOPAK SURVEY>COGO>Export Alignments and Profiles> Leica Road Plus - When

Exporting a Profile with a VPI at the end of the profile, the last VPI does

not get included in the export, Instead it uses the station of the last

VPT.

FABD-5FKKS6

SURVEY>DATACOLLECTION>DATA TRANSFER: on TDS raw datasome set ups are not

being created in the OBS file despite being in the raw data

FABD-5FNSF7

SURVEY>DATACOLLECTION>DATATRANSFER>DOWNLOAD TO DATACOLLECTOR>COORDINATE

FILE: transferring points from the GPK file to the SDR33 produces the

following message: "mdl detected mismatched type for a return value. mdl

abort in cmp_pts.c at line 77"

FABD-5FDSVU

SURVEY>RAW DATA EDITOR> OBS EDITOR: a) Linking codes pull down menu

disappear when deleting a Point, they will reappear after rebuilding the

chains.

FABD-5FTJHB

SURVEY>COGO>BEST FIT: The best fit line disappear when the weight of the

first point is changed.

MMOY-5G2LFG

SURVEY>ASCIIXYZ>PROCESS SURVEY: Problem with points with Double codes, 

SURVEY>ASCIIXYZ>the

DUP point is not being created in some cases, and this causes that some 

points will not be included in the chain, chain ending where it is not supposed 

to end, incomplete chains. Also due to the above problems the following error 

appears on the log file :

*ERROR: Line [3] .. At point 51057. No previous cpoint was given for continuation

*ERROR: Line [10] .. At point 51064. No previous cpoint was given for continuation

GEOPAK MR2001 Update 2001.01.05

Updated File(s):

sbdiv.ma

sbdiv.dll

Description:

This update resolves the following change tickets:

FABD-5EHKN2

SURVEY>PARCEL SUBDIVISION WIZARD>MISC: Problems defining "Frontage" when 

the original parcel has been stored Counter Clock wise.

FABD-5EGKPR

SURVEY>PARCEL SUBDIVISION WIZARD>EDIT LINES: Getting error message "System 

fault :144 mdl abort in subdiv.mc at line 3442" when changing the editing 

option of a line from HINGE PT & DIRECTION to "adjust line Perpendicular/radial".

GEOPAK MR2001 Update 2001.01.06

New File(s):

dtmcam.ma

Description:

This update includes a new GEOPAK tool, DTM Camera,  that aids in the setup

of the Camera and the Target so that DTMs may be rendered and navigated with

ease.  This new tool must be loaded manually by MDL LOAD DTMCAM.MA.

GEOPAK MR2001 Update 2001.01.07

New File(s):

geodetic.dll

geod.ma

Description:

This update to the Geodetic Conversions module allows Minnesota Coordinate

systems to be selected as the source or destination coordinate systems.

GEOPAK MR2001 Update 2001.01.08

New File(s):

geodetic.dll

geod.ma

Updated File(s):

drain98.ma

drain98.dll

dtmgpk98.dll

gssectn.ma

site98.dll

site98.ma

sur2drg.ma

gsewer.dll

watsew.ma

geopak.exe

Description:

This update resolves the following change tickets:

WBER-5E5HMN

Description:  Geopak Drainage -> Drainage variables "Drainage Node Maximum Rise In" and "Drainage Node Maximum Rise Out" return incorrect values when Drainage Structure Cross 

Sections are processed.  

DCAT-5CRUG2

Description:  Geopak Drainage -> Preferences -> Instensity Options ->Travel Time> Corrected the problem where If you set this option to "Iterative" and design the network, then set travel time to any other option, and design, it can never recompute the time based on Iterative.  

MGIM-5CLM5M

Description:  Geopak Site Modeler -> Element Side Slope tool used along arcs the result appeared wavy.

BSHR-5DUP5Y

Description:  Geopak Site > DTM > Build Triangles - corrected problems where knots were found in the triangulation.

JVOE-5CRM2A

Description:  Geopak Site > Copy Parallel is not yielding proper results.

JVOE-5FLLHW

Description:  GEopak Survey > Survey to Drainage - Networks were not being located by lowest pipe elevation.

MGIM-5DER88

Description:  Geopak Site > Side Slope - certain elements created preclude the Object from Merging into the Model.

GEOPAK MR2001 Update MR2001.01.09

Updated File(s):

acbook.ma

cmp.ma

pavmark.ma

xs.exe

brtools.dll

sqlAccess.txt

sqlOracle.txt

sqlServer.txt

Description:

This update resolves the following change tickets:

GPKN-5DXSVC

The "quantity factor" in compute parameters definition is performing the 

multiplication operation twice for some element types.

DPAL-59PRP7

Computing in DBMS mode reports incorrect station and offset values for shape 

elements.

SLIN-5EJUHR

When computing in DBMS mode with a unit using 3PC method, and when the payitem 

name or description are redefined by 3PC, an error message "Row not inserted in 

TABLE PAYITEM." exhibited in the compute output window and an message "Code

meaning : IDispatch error #3105...Source : Microsoft JET Database Engine..."

SLIN-5GZQDD

When multiple complex shapes are computed using 3PC method only the quantity of 

one shape is reported.

SLIN-5GASWX

When complex elements are computed using 3PC method, sometimes it will not compute 

all the elements, also unable to modified the description and extended description 

values with adhoc attribute values when the element type is complex.

SLIN-5DN7DK

Computing in DBMS mode will not update quantities of elements that has been modified 

in the dgn file.

SLIN-5DN5VK

When exporting quantities to SDF files, the files were not created in the exact same 

format as previous versions, causing the import tool of Construction Manager to fail.

SLIN-5HSBFZ

Computing quantities along different baselines using adhoc attributes does not work for 

linear elements.

SLIN-5F7KWG

Computing using the 3PC method fails when multiple items are set up to quantify off the 

same element, a message "unable to invoke 3pc process" is exhibited instead.

BSHR-5GHL6M

When using the 3PC method to compute quantities, and if the resultant quantity is zero, 

this amount is still being exported to the quantity database.  Zero quantities should not 

be exported or reported.

SLIN-5GAVS3

When using the 3PC method to compute quantities, and a special unit that requires additional 

parameters is used (such as TN:t:d, M3:t, M3E:v etc.) a message "unable to invoke 3pc process" 

is exhibited instead.

SLIN-5G8TZW

When computing certain cell based quantities using the compute by view option, MicroStation 

exits with no error.

SLIN-5GATDA

When using the 3PC method to compute quantities from complex shapes, MicroStation aborts 

with error "System fault 144".  This error is only exhibited when 3PC method is used and 

not with standard units.

SLIN-5GZQ26

Customer requested enhancement.  Allow 3PC method to use custom unit handling. Currently 

the units are limited to standard units like LF, SY, CF etc. Custom units like "Tons", "SqYd" o

r "PerEach" will be desirable. The syntax for standard unit is:

   standardUnit = filename.3pc (Example: LF = trafficSeparator.3pc)

and the syntax for custom unit is:

   customUnit[elementMeasurement] = filename.3pc (Example: FEET[Linear] =

trafficSeparator.3pc)

where elementMeasurement may be "Each", "Linear" or "Area".

SLIN-5GZQA9

Customer requested enhancement.  Allow 3PC method to access the output unit. This may in some 

cases permit using a generic 3PC process to process "like"

payitems with varying units.  The syntax to access the computation unit is D&C ITEM UNIT.  An 

example would be to assign the unit to a string variable

(_s_unit = D&C ITEM UNIT).

JROS-5GXW3W

The pavement symbols application fails when the reference element for the symbols is a complex 

string (MicroStation element type 12).

SLIN-5JWMFH

When computing quantities with payitems defined using 3PC methods and the export format is 

SDF file, a message "invalid unit definition" is exhibited.

GPKN-52FGVL

When the DDB file contains payitems with no unit definition, computing quantities by fence 

will yield an error if the open mode is set to "Forms".

GPKN-5CUJCG, CLAN-5FP2EY

Error is encountered if a fit view is done before launching certain 3PC applications.

SLIN-5GCTJG

Design settings "Change Graphic Cell Symbology" does not always apply the symbology according 

to the toggle's state, in certain situations it appears to be out of synch.

CLAN-5FNJMS

Place influence does not "influence" elements when color number is above 127.

CLAN-5ELGMW

Proposed Cross Sections - Elements are being added to graphic groups even when the gg= option 

is not used.

DGRY-5FKLJN, DGRY-5EWN9H, SLIN-5GCSKN, DPAL-5JVJBC

When computing quantities with payitems defined using 3PC methods - Resolved memory issues 

with excess elements exhibiting errors such as "Unable to invoke 3pc process" or "Out of 

Virtual Memory".

DPAL-5JQNYB

Linear elements with custom line styles are not computed in the fence clip mode if the element 

are not completely within the fence.

DMAE-5LDG78

Compute mode fails when computing shapes containing many elements which cause the report to 

exceed one page.

SLIN-5KXAH4

Compute mode using 3pc method is not creating the extended descriptions in quantity database 

records when elements are partially overlapping in the dgn file.

DPAL-5KTJ6K

Compute mode locks MicroStation if the baseline chain specified is not found.

SLIN-5KX6VH

Compute mode using 3pc method is not creating the extended descriptions in quantity database 

records when elements are partially overlapping in the dgn file.

SLIN-5KX6VH

Compute mode returns a quantity of zero for linear elements when string processing for a 

payitem is set to Min/Max and 3pc is used to override the actual quantity.

DPAL-5JXM66, BSHR-56AKVT

A selection set is being unselected when a 3pc item is activated in design mode when the 

compute dialog view/fence setting was set to fence.

SLIN-5KX9WA

Compute mode using 3pc method is not creating the remarks, description and extended 

descriptions in quantity database records when elements loops backwards or share identical 

end points.

SLIN-5KX8TU

Compute mode aborts when a payitem is set to continuous string processing and the linear 

elements close back on itself (forming a loop) or overlaps partially.

SLIN-5KX5Z5

When using 3pc to override a quantity in compute mode, the computed quantity for linear 

elements are still set to the length of the elements instead of the 3pc defined values.

SLIN-5MKRD7

Compute mode is enhanced to optionally (set via Design & Computation Manager's Compute 

Settings dialog) to create a table to store element adhoc attributes in the Quantity Manager 

database.

CLAN-5M6N9Z

General performance improvement for 3pc computing.

SLIN-5GZQA9

Unable to assign a variable to the payitem unit when computing quantities using 3PC (for 

example using the syntax _s_unit = D&C ITEM UNIT).

DMAE-5LDS7E

When computing in SDF Compbook Forms mode an dialog stating "Invalid unit specification" is 

activated.

SLIN-5KX5Z5

When computing linear elements in certain situations 3PC overriding quantity values are not 

being honored.

SLIN-5N723E

Set Mode "corrupts" a shape sometimes by dropping the last vertex of the shape.  This problem 

is only exhibited in certain version of MSJ.

GEOPAK MR2001 Update 2001.01.10

Updated File(s):

gpkplt.ma

geopak.ma

Description:

This update is an addition to the Coordinate Geometry File menu to import

Virginia DOT's PLT file format into COGO GPK elements.

GEOPAK MR2001 Update 2001.01.11

Updated File(s):

sheetclp.dll

sheetclprn.ma

sheetclprm.ma

sheetclp.ma

sheetclp.cel

sheetlib.ma

Description:

This update resolves the following change ticket:

WBER-5DNNG2

With the drawing area set to an odd distance and the horizontal 

grid alignment set to something larger than 1.0 the station range 

for "Outside/In" and "Radial" sheet compositions is calculated in 

a manner that will not allow the desired distance to be entered.

WBER-5CM33K

Station labels are not placed correctly after an equation if the 

equation is an overlapping equation (station ahead is less than station 

back) and hence the same station label needs to be drawn multiple times.

WBER-5DGMUW

The tabular data annotation port is not being attached to the sheet 

file when the all the ports are set up as "Alignment Dependent".

WBER-5FTKHT

When a sheet border file is set to "Read Only" a recurring warning of 

this fact is being issued when creating each sheet file.  This message 

should be issued once at the beginning.

WBER-5G23WF

Clipping shapes in curved areas are not being placed in the correct 

location in some situations when the option "Take Clipping Shape From 

Sheet Cell" is used.

WBER-5EQS9H

When sheets for other alignments have been placed and renumbered using 

the Sheet Number Manager, subsequent placement of profile and tabular 

data ports on an alignment will yield multiple multiple shapes for the 

same port.

WBER-5EKKMU

When running Plan Profile Sheet Composition within Project Manager, and 

if a tabular data clipping shape is graphically identified from the Draw 

Tabular Annotation tool, an error would occur.

SLIN-5HS92E

Enhancement - the method by which sheet DGN files are named has been expanded 

to permit a pattern (beginning with a "[" character and ending with a "]") to 

be specified.  The pattern delimiters [] may appear anywhere in the sheet name 

prefix, not necessarily at the end.  Several options are supported.  Each option 

is illustrated below with an example using a series of sheet number 21, 22A, 22B, 

23...

(1) No pattern specified.  This will append the sheet number to the end of the 

sheet name prefix, thus if the sheet name prefix is "RdwyPlanSheet" the first sheet 

DGN file will be RdwyPlanSheet21.dgn, followed by RdwyPlanSheet22A.dgn, RdwyPlanSheet22B.dgn 

and RdwyPlanSheet23.dgn etc.

(2) A numeric pattern is specified.  The sheet DGN file name is constructed by 

incrementing the numeric value by one for each file generated and the original sheet 

number no longer plays a part in the file name.  If the sheet name prefix is "RdwyPlanSheet[1782]", 

the first sheet DGN file will be RdwyPlanSheet1782.dgn, RdwyPlanSheet1783.dgn, RdwyPlanSheet1784.dgn 

and RdwyPlanSheet1785.dgn etc.

(3) A replacement string containing the asterisk character "*" is specified.  The sheet DGN 

file is constructed by substituting the pattern with the sheet number. This is different from 

not specifying a pattern in that the number of * specified indicates a minimum length thus making 

provisions for padding with the zero digit.  If the sheet name prefix is "RdwyPlanSheet[*****]", 

the first sheet DGN file will be RdwyPlanSheet0021.dgn, RdwyPlanSheet022A.dgn, RdwyPlanSheet022B.dgn 

and RdwyPlanSheet0023.dgn etc.

(4) A substitution pattern is specified.  The sheet DGN file is constructed by partially replacing 

the substitution string with the sheet number, maintaining the length of the pattern while also 

preserving as much of the pattern as possible. A substitution string cannot be all numeric or all "*".  

If the sheet name prefix is "RdwyPlanSheet[7RD001]", the first sheet DGN file will be RdwyPlanSheet7RD021.dgn, 

RdwyPlanSheet7RD22A.dgn, RdwyPlanSheet7RD22B.dgn and RdwyPlanSheet7RD023.dgn etc.

The length of the pattern specifies the minimum length.  If the substitution is shorter than the pattern 

length, the minimum length is maintained by padding.  If the substitution exceeds the pattern length, the 

complete substitution string is used. No truncation will be performed.

WBER-5GKKV3

When the sheet library is set via the configuration variable GPK_SHEETCLP_SHEET_LIBRARY_DIR and 

GPK_SHEETCLP_SHEET_LIBRARY_NAME and the FORCE version of the variable is used, the application saves 

all sheet preferences to the configured sheet library even if another sheet library was opened and edited.

WBER-5HUJSP

If a chain begins in region 1 and the corresponding profile begins in region 2, the profile and tabular 

data annotation clipping shapes are placed incorrectly during the layout process.

WBER-5GKPMA

After sheets are renumbered in a numeric-alpha sequence (example 1A, 1B, 1C, 1D...) only the first sheet 

is clipped.

WBER-5HMJRM

When the bottom elevation of a profile clipping shape with stair stepping is modified, all steps in the 

same sheet are adjusted to the same elevation.

WBER-5JR4RX

When new sheets are being created, the reference file information is not fully preserved when the reference 

files were originally attached with Florida Department of Transportation's TIMS (Technical Information 

Management System).  Provision is made to retain the extra attachment information.

WBER-5KDPNC

Profile cliiping shapes are placed incorrectly for a profile that contains multiple equations plotted with gaps.

WBER-5LEP8X

When MicroStation workspace preferences tool size is set to Large, activating plan/profile sheet composition 

results in an error message "Unable to load/create dialog item of type 'Icon', id=..."

GEOPAK MR2001 Update 2001.01.12

New File(s):

geodetic.dll

geod.ma

gsmdfelm.ma

Updated File(s):

drain98.ma

drain98.dll

dtmgpk98.dll

gssectn.ma

site98.dll

site98.ma

sur2drg.ma

gsewer.dll

watsew.ma

geopak.exe

labeler.ma

tc.ma

seltblbl.ma

updlabel.ma

Description:

This update resolves the following change tickets:

WBER-5E5HMN

Description:  Geopak Drainage -> Drainage variables "Drainage Node Maximum Rise In" and "Drainage Node Maximum Rise Out" return incorrect values when Drainage Structure Cross 

Sections are processed.  

DCAT-5CRUG2

Description:  Geopak Drainage -> Preferences -> Instensity Options ->Travel Time> Corrected the problem where If you set this option to "Iterative" and design the network, then set travel time to any other option, and design, it can never recompute the time based on Iterative.  

MGIM-5CLM5M

Description:  Geopak Site Modeler -> Element Side Slope tool used along arcs the result appeared wavy.

BSHR-5DUP5Y

Description:  Geopak Site > DTM > Build Triangles - corrected problems where knots were found in the triangulation.

JVOE-5CRM2A

Description:  Geopak Site > Copy Parallel is not yielding proper results.

JVOE-5FLLHW

Description:  GEopak Survey > Survey to Drainage - Networks were not being located by lowest pipe elevation.

MGIM-5DER88

Description:  Geopak Site > Side Slope - certain elements created preclude the Object from Merging into the Model.

GEOPAK 2001 Update MR2001.01.13

Updated File(s):

xsreport.ma

Description:

This update resolves the following change ticket:

GPKN-4KUL7D,GPKN-4C5RN6,GYOO-493KEL

GEOPAK Cross Section Reports / XS List may skip a portion of the 

cross section if the cross section elements to be processed traverses 

backward (not progressing in a positive X direction).

IALO-5HSLJ8

GEOPAK Cross Section Reports / Multi Line - adjusted such that disjointed 

cross sections elements are still considered as long as they are connected 

by dislayed elements.  An example would be to create a report for proposed 

sections of a divided facility where there is a natural median connecting the 

two sides, but the natural median elements are not specified as part of the 

section element level symbology.

WBER-5LHNGU, WBER-5LHPK3, WBER-5LHQYX, WBER-5LLJJQ

Different behavior for XS List, Multiline, DTM Input and DTM Proposed 3D after 

adjustments to permit backward traversal.

WBER-5M3SNU

XS List does not recognize the full cross section if the section does not end 

on a dangling element (to close on the existing ground) but instead closes on 

itself in a boxed configuration.

IALO-5QBL5L

The Red & Blue Top Report tool does not find text that lies on a vertex of a 

vertical line segment.

GEOPAK MR2001 Update 2001.01.14

Updated File(s):

gpktools.ma

Description:

This update resolves the following change ticket:

AMAE-522G7Q

If the MicroStation User Preference for "Tool Size" is set to "Large" a 

error is exhibited when the GEOPAK tool frame is activated.

GEOPAK MR2001 Update 2001.01.15

Updated File(s):

gpktds.ma

gpkplt.ma

geopak.ma

alignmen.ma

coolcogo.ma

geopak.exe

hamn.ma

macgeom.dll

macrep.dll

Description:

This update resolves the following change ticket:

SMAN-5EPN9S

COGO File > Export > Alignments and Profiles > RDS - provided a 

choice of 3 or 4 decimal places on exporting to RDS in order to 

accomodate northing coordinate values exceeding 10,000,000.00.

GPKN-5DWJ35, AMAE-5EGLC9

COGO Element > Curve > Segment - computed incorrect curve length 

and middle

ordinate when offset option is used.

SLIN-5F7LZ4

COGO > File > Import - added import option for Virginia DOT's PLT 

geometry file format.

GPKN-58DQDF

Horizontal Alignment Tools - when curvature is set to degree (Chord) 

the curve length entered is being interpreted as true arc length instead 

of chord defined arc length.

FABD-5BXJNK

COGO > File > Load Input File - When processing input files to store 

survey points, those points without descriptions are being assigned a 

description.

GYOO-4H8NVP

Tables tool plots incorrect total PI coordinates for a spiral curve spiral 

construction if the entrance spiral length is not equal to the exit spiral 

length.

DGRY-5K7PZK

Importing Virginia DOT's PLT geometry file will lock the process if the import 

dialog shows a previously imported file and that file no longer exists.

AMAE-5MYQUF

Graphical COGO - Using the Store Point tool with a tentative snap on an element 

in a reference file causes an application error.

GEOPAK 2001 Update MR2001.01.16

Updated File(s):

xsserv.ma

drain98.dll

xs.exe

Description:

This update resolves the following change ticket:

GPKN-5CMKJ5, DPAL-5DHPW6,AMAE-5E6GCQ

Cross Section Sheet Layout - Station labels are placed on top of each other for 

different stations.

WBER-5ETNMV

3PC - Provisions made to process no name cells.

CLAN-5ELH35

3PC - Cells drawn to a profile drawing as part of a graphic group are not placed into 

the graphic group.

BSHR-5J8L3G

Proposed Cross Sections - When performing a draw trace of the existing ground to intersect 

xs elements, it goes to the second intersection when it intersects two xs elements between 

the end points of an existing ground element.

CLAN-5ELGMW

Proposed Cross Sections - Elements are being added to graphic groups when the GG option is 

not being used.

GPKN-535JMP

Proposed Cross Sections - Provisions made to control number of decimal places when using a 

% format to place text elements when the numeric value is a round number.

CLAN-5JTMY6

Proposed Cross Sections - Define dgn using DDB definitions is excessively slower than using 

by level symbology.

AMAE-5MAJVD

Proposed Cross Sections - Assign plot parameters to pavement sub layers. The default line 

symbology and the bottom of the input file is overriding the plot parameters specifed with 

each shapes pavement thickness.

CLAN-5MXHSS

3PC - Unable to processing the file completely when using READ ASCII to read an input file.  

This problem is intermittent and dataset dependent.

DGRY-5MYHVB

Proposed Cross Sections - The skew effect is not being honored when running shapeless criteria. 

The intrinsic variable skew effect for cluster is equal to "0" when it should be undefined in 

a shapeless context.

CLAN-5NPNZK

Proposed Cross Sections - Unable to search for plan view DGN elements using define ddb 

definitions if the ddb items contains custom line styles.

GEOPAK 2001 Update MR2001.01.17

Updated File(s):

projmgr.ma

runpick.ma

prjxs.ma

typical.ma

Description:

This update resolves the following change ticket:

CLAN-5DTR7R

Proposed Cross Section's Exposed Redefinable Variable Editor dialog accepts 

only 1000 chatacters.  If this limit is exceeded saving the changes back to 

the project manager database will yield a system fault 5 error.  The limit 

is now extended to 3000 characters.

DGRY-5KYKBX

When projects are located on a particular server the Road workflow dialog comes 

up extremely slow (45 seconds - 1 minute).  A redundant save was performed when 

the Road workflow dialog opens and this step is now removed to optimize the process.

IALO-5EKRUD

When copying a run from a project database that has readonly permission, the run 

data is not copied completely and correctly.

IALO-5PHJRV, DGRY-5RQHSV

Project Manager run index exceeds 255 which causes the run database to be corrupted. 

Optimized run capacity by compressing and purging deleted runs.

HOEN-5Q5MVF

Project Manager - Proposed Cross Section's Typical Section tools does not activate 

the description when an UNC name is used to specify the working directory.

CLAN-5U4SPG

Project Manager - increased the default size of the ERV editor dialog to minimize the 

initial adjustments by the user.

DGRY-5R2QYH

Project Manager's file histroy list occasionally corrupts the application resource file 

when runs are accessed via histroy selection instead of the run picker.

GEOPAK MR2001 Update 2001.01.18

Updated File(s):

liccp.ma

Description:

Error messages when activating CivilPAK: MDL abort in sslocal.mc at line 360 

MDL abort in gpkserv.mc at line 1277 MDL detected a bad format string. MDL 

abort in sslocal.mc at line 360 MDL abort in gpkserv.mc at line 1277.

This update resolves the following change ticket:

CivilPAK not activating properly with a checked out license from a SelectServer.

GEOPAK 2001 Update MR2001.01.19

Updated File(s):

profgen.ma

Kvalues_1990english.kvl

Kvalues_1994metric.kvl

Kvalues_2001english.kvl

Kvalues_2001metric.kvl

Description:

This update resolves the following change ticket(s):

SLIN-5MKRZ7

AASHTO 2001 K vakue table uses a single value (the maximum column) 

instead of a range, the algorithm for indexing design speeds from K 

values has also been modified to ensure a conservative interpretation.

BSHR-5NFM8X

For crest curves with option "Maintain VC Length" set in preferences; 

when a design speed is selected the K value is used for that design speed 

but the design speed shown in the option button is one entry lower (i.e. 

when 35 is selected, 30 is shown, although the K value for 35 is used).

GEOPAK MR2001 Update MR2001.01.20

Updated File(s):

superngn.dll

superdlg.ma

shpmgprf.ma

english_1990.sep

english_1990_AASHTO_V_e.csv

english_1990_eTable_l.csv

english_1990_radiusTable_e.csv

english_1990_RGtable_l.csv

english_2001.sep

english_2001_AASHTO_V_e.csv

english_2001_eTable_l.csv

english_2001_radiusTable_e.csv

english_2001_RGtable_l.csv

metric_1994.sep

metric_1994_AASHTO_V_e.csv

metric_1994_eTable_l.csv

metric_1994_radiusTable_e.csv

metric_1994_RGtable_l.csv

metric_2001.sep

metric_2001_AASHTO_V_e.csv

metric_2001_eTable_l.csv

metric_2001_radiusTable_e.csv

metric_2001_RGtable_l.csv

Description:

This update resolves the following change tickets:

PSCM-5KP28Q

When computing superelevation along an asymmetric roadway (different number 

of lanes on each side), index the adjust factor using the number of lanes 

on the outside (high side) of the curve.  This enhancement conforms to the 

Michigan DOT standard for variable Adjust Factor.

PSCM-5FKSD7

Added a new concept of "Number of Lanes Rotated" to be compliant to AASHTO 

2001 Green Book changes.  When indexing for adjust factors of multi-lane 

roadways, both "Total Number of Lanes" and "Number of Lanes Rotated" are 

supported.  The default value will be "Total Number of Lanes".

PSCM-5KNVXD

When computing superelevation along a roadway with a broken back normal crown 

section, add a provision such that the transition is carried out linearly 

based on the pavement edge relative profile.  Current default behavior is to 

carry the transition linearly based on cross slopes.

AMAE-5NVG4S

Tangent runout distance were incorrectly computed when using the By Equation 

option.

DPAL-5EAH62

When computing superelevation for a divided facility and the profile grade 

point (tie value) is located beyond the median edge of pavement the cross 

slope values of the interior lanes were being computed incorrectly.

GEOPAK MR2001 Update MR2001.01.22

Updated File(s):

geopak.exe

xs.exe

Description:

This update resolves the following change tickets:

GEOPAK MR2001 Update MR2001.01.23

Updated File(s):

shapemgr.ma

Description:

This update resolves the following change tickets:

SLIN-5RXNY6

Shape Analyst and Shape Profiler aborts for certain shapes when PGL chains are defined.

